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Overview of the 25-Year Long

Range Transportation Plan




Tennessee’s
25-Year Long-Range Transportation Plan

The two main deliverables of this project:

« 25-Year Long-Range Transportation Policy Plan (Policy Plan)
» 10-Year Fiscally Constrained Strategic Investment Program

Other deliverables:

 An Updated Statewide Travel Demand Model
* An Updated Customer Satisfaction Survey
A Financial & Revenue Forecasting Model
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Tennessee’s
25-Year Long-Range Transportation Plan

« Address Growing and Changing Demands
« Action-Orientated Policy Plan
* Include a 10-Year Strategic Investment Program

* Drive TDOT's 3-Year Transportation Program
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Policy Papers

 Topical Areas

— Demographic and Employment Changes & Trends: Population
& Economic Conditions

— Travel Trends & System Performance

— Financial Revenues & Fiscal Outlook

— Safety, Security, & Transportation Resilience

— Freight Transportation: Movements & Infrastructure

— Mobility: Public Transportation, TDM, & Non-Motorized Modes

— Accessibility: Land Use Planning, Access Management,
Complete Streets, and Health & Environment

— Coordination, Cooperation, & Consultation
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Tennessee’s
25-Year Long-Range Transportation Plan
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Continuous Public Outreach

* Project Website
* Online Survey
* Book-a-Planner

www.tdot.state.tn.us/transportationplan
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Phase 1 of the Statewide Model

Update: Data Development




Statewide Model Update

Existing Statewide Model New Statewide Model
« 2003 Base — 2030 Horizon « 2010 Base Year — 2040 Horizon Year
* Only Total Daily Traffic « Peak Hour and Daily Traffic
+ Limited Network Coverage » Expanded Network Coverage
* Limited Sensitivity * New Sensitivity to:
- Re-routing Only - Network changes

- Induced demand
— Alternative future land use scenarios
- Population changes (aging, etc.)
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Statewide Model Update: Phases 1 & 2

Phase 1: Data Development Phase 2: Model Development
(currently underway) (2014)
* New, Expanded Network * New Trip-based Model
* New, More Detailed Zone System » Time-of-Day Modeling
- Obtain & Process Socioeconomic (peak hour volumes)
Data » Destination Choice Models
* New Socioeconomic Forecasts (greater accuracy)
« Obtain & Process ATRI Truck GPS + Possible Pivot-Point Structure
Data (greater accuracy)
« Combine NHTS & MPO Household * Truck/Freight Modeling still being scoped
Travel Survey Data » Post-processing for Performance

Measures (access to jobs, hospitals, etc.)

Employment
[otos
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Zone Size and Network Coverage

Ohio lowa Indiana Tennesse v1 [Tennessee v2

Population 11,500,000 3,100,000 6,500,000 6,500,000 6,500,000

Road Miles* 42,000 45,000 19,000 9,421
TAZ in state 3,660 1,866 4,690 1,222
Total TAZ 5,116 3,314 4,831 1,397
Pop / TAZ* 3,200 1,600 1,400 5,300
Acres | TAZ® 12.2 30.2 7.8 34.5
Miles / Acre 0.9 0.8 0.5 0.2
Pop / Miles 270 70 340 690
Miles /| TAZ 11.5 24 .1 4.1 7.7

*in state

« TAZ and network for new Tennessee model are current estimates
 New model probably will have the network and zones
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Network Development




Defining the Network

How do we decide what to include in the network?

Old Model

* Interstates & Principal Arterials

New Model

 Started with minimum criteria
- Anything in the old model
- Anything in the National Highway Planning Network (NHS, etc.)
— All minor arterials

« Want network coverage one class lower than desired forecasts

* Began to look at TRIMS data, to consider volume thresholds, etc.

* Found the TRIMS Traffic layer (e.g., roads with TDOT traffic counts)
has roughly the right level of network coverage

« Had to add ~100 links to minimum criteria

« May still remove a small number of roads to ensure good balance
with TAZ

11/14/13
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Defining the Network

New vs. Old Network

TRIMS Traffic Layer
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Network Topology: Connectivity & Routing

Model Requirements

« Connected and routable network

Options

* Connect TRIMS GIS layers — Not enough time & budget
* TN OIR E99 layer — Not ready until 2014

» TeleAtlas network — Chosen

Issues

* How to connect with TRIMS

 TRIMS missing ramps

« Elevation (Z) data
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Network Attributes

Chosen Attributes
 Design « Administrative
— Direction - Functional Class
— Divided - Ownership
- Access Control - Cou.nty
- Lanes | * Intersection T 15.94%
- Lane width - Control Type -
_ Shoulder width Divided LD
_ Terrain Lanes 0.03%
- Speed Limit Missing Attributes  AADT 0.05%
* Traffic * Most attributes substantially complete
- AADT * 90% of roads with missing speed are rural
— Peak hour % minor arterials
— MU Truck % « Speed is missing on roughly half of this class
— SU Truck % * No volume / geographic pattern — ok to impute
/\
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Network Development Process

Getting the TRIMS attributes on the routable TeleAtlas network...

* Develop a Least-Common-Denominator (LCD) TRIMS line layer network
with a nodes anywhere a chosen attribute changes

» Get all the TRIMS attributes onto the single LCD layer

» Simplify and reduce the LCD representation above if possible

» Develop a common segmentation between LCD TRIMS and TeleAtlas

» Pass the TRIMS attributes over onto the newly segmented TeleAtlas layer

« Simplify the newly segmented TeleAtlas layer (remove unnecessary nodes)
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TAZ Development




A Good Lookin’ TAZ

What should a TAZ look like? What makes for a good TAZ?

Traditionally

» Zone boundaries conform to the network

* And other boundaries, maybe

 And homogenous land use, maybe

Travel Sheds

« Zones as catchment areas around network
Borrowed from hydrology

First used for TAZ in NW 20+ years ago
Increasingly common in statewide models

Clearer relationship to the network, less ambiguity
about loading points / centroid connectors

Better able to represent distinct rural and small
urban zones

» Take other boundaries more seriously

11/14/13
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Building Blocks

What are the statewide TAZ made of?

Urban

» Aggregations of MPO zones

» Mix of traditional and travel sheds

Rural / Small Town

» Aggregations of Census blocks? (Or overlay?)
 Less traditional, mostly travel sheds
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Putting the Puzzle Pieces Together

How do you group MPO zones / Census blocks into SWM TAZ?

Clustering
» Groups nearby/similar blocks together

 Similarity / proximity can be defined

* Does not ensure contiguity (can have “islands”)

» Does not ensure compactness (can have “tentacles”)
Partitioning

» Takes clusters as input

« Ensures contiguous, compact, balanced zones
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Matchmaking

So how do you cluster blocks? What does “nearby” or “similar” mean?
Distance Function

« Combines various measures of proximity and similarity into a single measure
“Distance” =TT +aD + bC + cP + dHX + eWX + fRR + gMX

TT. travel time (from TeleAtlas)

D: Simpson’s D dissimilarity statistic calculated from pop, ind emp, com emp
C: Different County (binary)

P: Different Census Designated Place (binary)

HX: Major (access controlled) highway crossings (# of)

WX: Major water crossings (# of)

RR: Railroad crossings (# of)

MX: Ridge line (Mountain) crossings (# of)

a, b, c,d, e, f, g weights (minutes of penalty per unit of variable)
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Matchmaking

So how do you cluster blocks? What does “nearby” or “similar” mean?
Distance Function
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Matchmaking
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Easy Criteria

Counties

Places
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Harder Criteria

Slopes, Ridgelines and Water Features

* Plenty of water layers, but how to define “major”

* No canned “ridgeline” layers

» Created ridgelines by processing DEMs

* Tried to define “internal” criteria

* Instead, used visual inspection against TeleAtlas, looking for network gaps
* Found slopes more a barrier than ridges in some areas

11/14/13
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Diversity vs. Homogeneity

How do you measure “homogenous land use™?

Diversity or Dissimilarity Statistics
 Lieberson’s (1969) D statistic

— Measures the probability that two items drawn at random from two
different samples will belong to the same category

dy=1-) [P,©O][P,©)]

- Defined on the interval [0,1]
- Two zones with all items of only one category have d = 0
- Two zones with no category with an item in both zones have d = 1

- For “land use” we simply take each household, commercial job and
industrial job as an item
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Socioeconomic Data

Development




Demographics

Decennial Census

» Population, Households, Children, Seniors

 Block level data

American Communities Survey

* Workers, Vehicles, Income

 Block group level available

 Disaggregate to blocks proportionally to households
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Employment Categories

» Using standard 20 two digit NAICS categories for data development
* May combine categories later if not needed for the model

NAICS Code Description

31-33

44-45
48-49

11
21
22
23

42

51
52
53
54
55
56
61
62
71
72
81
92

Agriculture, Forestry, Fishing and Hunting
Mining, Quarrying, and Oil and Gas Extraction
Utilities

Construction

Manufacturing (31, 32, 33)

Wholesale Trade

Retail Trade (44 & 45)

Transportation and Warehousing (48 &49)
Information

Finance and Insurance

Real Estate and Rental and Leasing
Professional, Scientificand Technical Services
Managementof Companies and Enterprises
Administrative and Supportand Waste Managementand Remediation Services
Educational Services

Health Care and Social Assistance

Arts, Entertainment, and Recreation
Accommodation and Food Services

Other Services, except Public Administration
Public Administration

v
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Employment Data Sources

InfoGroup
 Purchased data for all Tennessee

* Individual business with lat, long locations

« Based on phone surveys, aggregated data

LEHD

 Freely available federal data

 Employment by NAICS category by Census block

» Based on administrative (tax) records,
with some ‘fuzziness’ added to preserve privacy

BEA

* Freely available federal data

 Total employment by NAICS category at County level

Woods & Poole

» Purchased data including employment forecasts consistent with BEA
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Using InfoGroup and LEHD Together

Cleaning
« Compare differences and correlations look for outliers

Combining

« Both InfoGroup and LEHD account for roughly 85% of BEA

« |f they are independent, together they would account for 98% of BEA
« Research in Ohio suggests they are close to independent
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Using InfoGroup and LEHD Together

Cleaning
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Socioeconomic Forecasts




County Control Totals

Sources of Forecasts
UT’s Center for Business and Economic Research (CBER) — population only

Woods & Poole
MPQ forecasts
Historic growth rates and trends

Anderson County Population
Projections

105,000 -

100,000
95,000
90,000
85,000
80,000
75,000 .
70,000 *
65,000
60,000

55,000 T T T r r r )
1980 1990 2000 2010 2020 2030 2040 2050

xp

@Historic ACBER ¢W&P XLowestPost'70 ®Avg.'70-'10 +HighestPost'70

” 11/14/13 36

Bl RSG



Allocation to TAZ

MPO areas
« Use MPO growth allocations

» Absolute growth may not match exactly if control totals differ,
but same pattern will be assumed

Non-MPO areas

» Allocate future growth near/where growth has occurred historically
- Population:  Census 2000 & 2010
- Employment: LEHD 2002-2012

11/14/13
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ATRI Truck GPS Data




ATRI Truck GPS Data

What's ATRI?

American Transportation Research Institute (ATRI)
 non-profit funded by the trucking industry

* Receives over 4 Billion GPS truck positions annually from member
organizations

» Cannot disclose the individual raw truck traces, but can provided
processed data products which avoid disclosure

Basis of FHWA's Freight Performance Measures Webtool
Used for major corridor studies, 1-95, I-70

Incorporated in Indiana & lowa’s statewide models

Now in the process of acquiring data for Tennessee

11/14/13
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Indianapolis




24 Hours




48 Hours




72 Hours




5 Days
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7/ Days
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Indiana Experience

Data Method
» Eight week sample » Used existing commodity-
« 16 million records flow based model to pivot

. 305.000 trucks off of expanded ATRI data

» 2 million truck trips

Results
Model 2006 Model 2010 Model
Observations 6,689 5,898
Avg. Count 1,379 1,264
RMSE 69.3% 60.6%
Avg Error 5.4% -0.1%
MAPE 74% 42%
& ;13/(1;4/13



Data Processing

What constitutes a stop?

Anonymized GPS records converted to ODs
* Criteria based on speed and time
» Duration of a stop necessary to avoid counting traffic stops as destinations

elapsed
time
10/ 101032 66.0 57.7 57.7 68.6|moving |moving
101032 101033 16.3 14.3 72.0 68.6moving |moving
101033/ 101015 26.8 27.9 99.9 57.5moving |moving

from TAZ to TAZ distance time

speed status1 status2

101015[ 101015 0.0 5.0 5.0 0.0stopped |stopped Trip o D
101015/ 101015 0.2 2.7 7.7 5.2stopped |stopped -

101015/ 101015 0.3 o8 175 2 Ostopped _|stopped 1 10| 101015
101015/ 101015 0.1 0.3 0.3 28.2moving |stopped? 2 101015/ 18023

101015/ 2035 37.1 60.0 60.3 37.1moving |moving
2035/ 18099 67.8 65.4 125.7 62.2lmoving |moving

18099, 27006 5.9 54 131.1 65.3moving |moving
27006/ 18023 10.0 15.9 147.0 37.8/moving |moving
18023 18023 0.0 5.0 5.0 0.0|stopped |stopped
f‘ 11/14/13
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Data Expansion

It's a big sample, but it’s still a sample.

Simple Scaling
« Single uniform expansion factor
- sample truck VMT to HPMS truck VMT
Complex Weighting
* Varying weights by
- Region
— Trip length
» Weights developed by analyzing results of ODME
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Household Survey Data




Combining NHTS & MPO Surveys

Datasets
« NHTS Add-On for Tennessee
- Oversampled rural areas
« MPO surveys
- Complete/complement NHTS
- May not use all MPO surveys
Re-weighting and combining

ACS vs Unweighted

. Controls ACS vs Weighted
- Region
- Household size by vehicles
- Person age

 lterative Proportional Fitting
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Results of the MPO Survey




TN MPO Travel Demand Model Survey

* Online Survey

« Conducted between Sept to Oct 2013
« 20 Questions

« Completed by all 11 TN MPOs
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TN MPO Travel Demand Model Survey Results

What counties does your travel demand model cover?

« MPQO models cover 42 counties (29 in TN and 8 in other States)
« Other States include: Georgia, Kentucky, Virginia, & Mississippi
 MPO models range from 1 county to 10 counties in size
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What is the Base Year of your currently
approved model?

« Base Years range from 2004 to 2010
« Six models have a Base Year of 2010

What is the Last Horizon Year of your
currently approved model?

* Future Years range from 2035 to 2040
* Future Year - 4 have 2035 - 7 have 2040

What other interim horizon years are part of
your model?

 Most models have interim horizon years

TN MPO Travel Demand Model Survey Results

11/14/13
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TN MPO Travel Demand Model Survey Results

When are you looking to update your model?

* Four are currently updating their model
(Bristol, Chattanooga, Nashville, & Memphis)

e Fivein 2016

What will be the Base Year of the new model?

 Three are looking at 2010
* Others range from 2012 to 2017

11/14/13
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TN MPO Travel Demand Model Survey Results

What data was used for your Base Year
POPULATION control totals?

e 2000 and 2010 US Census data most cited

What data was used for your Future Year
POPULATION control total projections?

9 of the 11 used Woods & Poole for the future
year population projections
» 4 referenced UT's population projections

11/14/13
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TN MPO Travel Demand Model Survey Results

What data was used for your Base Year
EMPLOYMENT control totals?

e 7 MPOs referenced Woods & Poole

» Other sources: InfoGroup, Dun & Bradstreet, Bureau
of Labor Statistics

What data was used to allocate your Base Year
EMPLOYMENT to the TAZ?

8 MPOs referenced using InfoGroup data

What data was used for your Future Year
EMPLOYMENT control total projections?

e 9 MPOs referenced Woods & Poole data

” 11/14/13
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TN MPO Travel Demand Model Survey Results

TDOT is considering several options for other data that could be
available to MPOs; which of the following are you interested in:

Woods & Poole Economics (Economic & Demographic Data)

« 7 would Love to Have

4 would be Nice to Have

InfoGroup (Locational Employment Data)

« 8 would Love to Have

« 3 would be Nice to Have
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TN MPO Travel Demand Model Survey Results

What type of freight data was used in your current
travel demand model?

« 6 MPOs referenced TRANSEARCH data
4 MPOs referenced FAF Commodity Flow data

What freight data are you likely to use in the future?
« TRANSEARCH data: 2 Certain / 4 Likely / 5 Possibly

 ATRI Truck GPS data: 3 Certain / 1 Likely / 7 Possibly
 FAF data: 2 Certain / 3 Likely / 6 Possibly

TDOT is considering several options for freight data;
which of the following are you most interested in: ?

« 9 MPOs used Woods & Poole for the future year
population projections

« 4 MPOs referenced UT's population projections
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TN MPO Travel Demand Model Survey Results

TDOT is considering several options for freight data;
which of the following are you most interested in:

TRANSEARCH data
« 3 -1stChoice, 5 - 2nd Choice, 3 - 3 Choice

ATRI Truck GPS data
« 4 -1stChoice, 5 - 2nd Choice, 2 - 3 Choice

FHWA FAF data
« 4 -1stChoice, 1 - 24 Choice, 6 - 3" Choice

11/14/13
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TN MPO Travel Demand Model Survey Results

How best can TDOT and their consultant involve you
in the update of the statewide travel demand model?

 Emall
« TNMUG Meetings

 Periodic Conference Calls

11/14/13
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Preview of Phase 2 of the

Statewide Model Update




Phase 2: Model Development

Advanced Trip-based Passenger Model
» Advanced trip generation

 Destination choice models

* Peak hour models

Truck / Freight Model

« Still being scoped

Validation

Post-processing

* Traffic statistics

» Post-processing

11/14/13
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Advanced Trip Generation

Non-linear Regression Models
 Allow multiple explanatory variables
— Effect of area type /accessibility
- Effect of seniors / children
» Capture both rational non-linearities
— Diminishing returns to scale
- Interaction effects
Poisson Distributed Household Variables
* Reduces aggregation as in cross-class
» But don’t require stratification curves, etc.

Poisson Distributions

Source: Wikimedia Commons

11/14/13
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Destination Choice Models

Account for More Factors
 Number of Attractions
» Travel Time / Impedance

Effect of Residence Location
on Willingness to Travel Trip Chaining in Knoxville

Psychological Boundaries
- River Crossings
- Ridgeline Crossings
~ Major Highway Crossings m
- State / County Line Crossings *
Walkability of Destination M§
Mixture of Land Uses at Destination Fewer, Longer Rural Trips

» Convenience for Trip-Chaining More, Shorter Urban Trips
» Spatial Auto-correlation Effects

N 11/14/13 65

Bl RSG



Peak Hour Models

Nested Logit Models
* Must account for duration of long trips

» Upper nest determines at least some portion of the trip occurs in the
AM peak hour, PM peak hour or both

» Lower nest determines how much of the trip occurs in the peak hour
» Will consider differences in peak hour factors related to

— area type / accessibility of origin and destination

— trip length

- region
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Truck / Freight Model Options

Three Options

* ATRI-based Truck Models

« Commodity flow-based Freight Models

» Supply Chain Logistics & Truck Tour Simulation Models
Considerations

* Budget

» Schedule for Long Range Plan

« Availability of Required Data

« Ability to Evaluate Potential Projects
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Truck Models

Model Structure
» Three step, like traditional passenger models
« Segmentation
- by vehicle type
light commercial vehicles
single unit trucks
multi-unit trucks
— by trip type
commercial passenger trip
service delivery trip
freight delivery trip
Can be developed based on ATRI data, pivot off of ATRI data

New truck-rail intermodal facilities can be handled by special
diversion module

Inexpensive and quick to develop

11/14/13
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Commodity Flow-based Models

Model Structure
« Commodities produced, consumed & exchanged
* Four step, like traditional passenger models

* Must be used together with truck models
since only long-haul freight movements included

Other Modes

« Can provide information on freight movements
by modes other than truck

 Limited ability to model freight mode shifts
 Rail assignment still experimental
Commodity Flow Data

« Transearch requires considerable cleaning
* FAF requires considerable disaggregation
Moderately Expensive to Develop

Coal Crude Oil

Moderately Time Consuming to Develop Mode Shares Mode Shares
/\
& ;13/(134/13 69




usiness

Supply Chain Logistics &
Truck Tour Simulation Models

Model Structure
* Firm synthesis (like population synthesis in ABMs)

» Simulated negotiations between shippers,
carriers, 3PLs

- agent-based computational economics
L oame Teen () e e e

* For truck mode, simulation of tours as in ABMs

Networks (Line-haul
distance, Access,

Most Realistic Freight Mode Choices o
Data Hungry Lo
Expensive to Develop I
Time Consuming to Develop I
SR =
SR
/\
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Validation

Demand Validation %RMSE for Statewide Models
» Generation Rates from NCHRP 08-36-91
« Trip Lengths Avg +
Assignment Validation 1 | 5000 [P 101.4
» Will produce similar statistics m 51.2 56.3
as for MPO models = 2l
« Different criteria for statewide models 20000 30000 324 39.7
201 320
40000 50000 18.0 19.8
50000 60000 18.6 20.5
60000 22.2 244
Total 54.5 60.0
VAN
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Vince Bernardin, PhD, RSG

Contacts

812.200.2351

www.rsginc.com
Preston Elliott, RPM

615.370.8410




Palette (save me)

The palette must be saved by EACH computer using the template. Go to
Design> Colors> Create new theme color. The default colors will be the RSG
colors. Give it a name and SAVE. Otherwise, the first time you change colors
you will lose the palette

Pop/accent colors

Red: 246
Green: 139
Blue: 31

Red: 72
Green: 72
Blue: 764

R: 127,G:127,B: 12

Main colors Neutrals of grey and light warm yellow
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